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1. Programmer Structure
1.1. Programming Structure
HY11P/HY12P Series Writer can program and doing other related function through connecting
with PC as Figure 1-1. Moreover, HY11P Series Writer also can be HY-IDE USB Control Board and
used on Emulate, Debug and some functions for developing. Regarding to the detailed description,

please refer to Hardware User Manual (http://www.hycontek.com/e-page2.html)

HY11P / HY12P Series

HY11P / HY12P Series Writer

Figure 1- 1
1.2. Diagram
HY11P/HY12P Series Writer is the tool connects with PC for programming HY11P/HY12P Series
products. You can program HY11P/HY12P series products by using HY11P/HY12P Series Writer as

shown in Figure 1-2.

- ]
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Figure 1- 2
1.3. Operation Description
The table in below gives description of every device:

Name Function Description

J1 Adapter 9V input 8—2—E ysed when programming OTP.
USB connector to PC end :

uée Downloading programming code for HY11P/HY 12P series.
Downloading program for emulation and debug.
J3 Connect the control end of HY-IDE ICE Board (A09001-2).

Programming control end of HY11P/HY12P series and is connected to OTP.

P3 Pins from the left to right are : VSS, VDD, SDO, SDI, SCK, VPP.
Programming extension port ; Please refer to Figure 1-3 for pin definition and

P connected circuit. Program (S1), Blank (S2), Green (L1), Red (L2).

L1 Power-on signal.

Programming success signal.

Blank Check Fail signal.
L2 Programming failure signal.

HAO frequency calibration failure signal.

L3 Busy message signal.

S1 Program ; IC programming button.
S2 Blank Check ; IC blank check button.

S3 Information ; Writer information check button.

- ]
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Blank -------- R RED
Program----5 | 1} ,---- Green = RED
= ¥ g % Y rERn
e 0000 Voltage S K]
VE5e---- 000 source 4710
00QQ0Q 2 0
VPP § § § © L vss [l N o
PTLIO =% § i %o VDD O 0 | Voltage
PT1.1 o3& . PT1.5 Source
Figure 1- 3

Note: A voltage will be outputted from Voltage Source when implementing Blank & Program.

1.4. Comparison of Differen

t Writer Version

Description of Different Writer Version
1 | Writer model HY10000-WKO01/ HY10000-WK02 HY10000-WKO05
2 | Support IC model HY11P/HY12P Series HY11P/HY12P Series
3 | Turn-on program auto check Low High
4 | Programming time limit support support
IC frequency hardware
5 | calibration function VA 2MHz HAG
IC frequency deviation
software calculation N/A HAO and LPO
6 | function
7 | Auto key button function Blank, Program, Verify Program, Verify
8 | LED light display L1/L2 (/L3) Green/Red Green/Red/Red
HYIDE software support Only support HYIDE V3.0 and later
o | version Support all HYIDE version version
Support the whole series HYIDE
Hex Code
1.x version Hex Code, Have to download the Hex Code into
10 downloaded from HYIDE V1.6 to writer WKO05 via HexLoader
Hex code download support
writer software.
2.x version Hex Code,
downloaded from HYIDE V2.x to
writer
The HexLoader software only supports downloading Hex file
11 |HexLoader Software Support| function, which applicable for writing hex code into WK01, WK02
and WKO5 writers.

© 2011-2012 HYCON Technology Corp
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s<Writer version comparison will abbreviate”’HY10000-“, showing only WK01, WK02 and WKO5.

1.  Writer Model: There are three versions: WK01, WK02 and WKO5.

2. IC Model Support : WK01, WK02 & WKO05 can program the whole series of HY11P/HY12P IC.

3. Turn-on program auto check : WK01 & WKO02 has low-tier turn-on auto check mechanism while
WKO5 possesses high-tier turn-on auto check mechanism as to ensure data correctness.
When power on, writer will check the correctness of the code-to-be programmed by
confirming its Check sum. Therefore, “Verifying... "will show up when power on. After
confirmation, HYCON IDE will show up in order to assure data correction and to begin
programming. If the check failed, “Verify error 6” will show up, representing the code-to-be
programmed is incorrect and must be reloaded again.

4. Programming time limit : WKO1, WKO02 and WKO5 support this function; please refer to “2.2.2 Build
Options” for further description.

5. IC frequency hardware calibration function : WK01 and WKO02 did not support frequency (2MHz HAO)
hardware calibration function. WK05 supports 2MHz HAO frequency hardware calibration
function, for related description, please refer to "2.2.4 OSC Calibration”.

6. IC frequency deviation software calculation function : WK01 and WKO02 did not support frequency
deviation software calculation function while WKO05 supported HAO frequency and LPO
frequency software deviation calculation function. Further description, please refer to ”
2.2.4 OSC Calibration”.

7. Auto Key button function : The auto programming order of WK01 and WKO02 is
Blank—Program—Verify. WKO05 removes Blank function, thus the auto programming order
is: Program— Verify as to facilitate users implementing repeat programming operation (the
purpose is to write repeatedly the same code ; This move will not erase IC. If the code is
different, then repeat programming will cause programming failure).

8. LED light display : The Green/Red light of WK01 and WKO02 represent OK/Error.
Green(L1)/Red(L2)/Red(L3) light of WKO05 represents OK/Error/Busy respectively. In
process of programming, the L3 will be lighted up and when programming finished, the L3
will go out. At this moment, the L1 lighted up means programming is successful.
Oppositely, the L2 lighted up means programming is failed or HAO frequency calibration
failure.

9. HYIDE software version support : WK01 and WKO02 support all versions of HYIDE and WKO05 only
supports HYIDE V3.0 and later version and HyconIDEDMM V3.0 and later version,

10. Hex Code download support :

WKO01 and WKO02 support the Hex Code assembled by the whole version HYIDE. However,
Hex Code of HYIDE V1.X version must be downloaded from HYIDE V1.6 to the writer and
Hex Code of HYIDE V2.X version must be downloaded from HYIDE V2.X version to writer.

© 2011-2012 HYCON Technology Corp APD-HYIDE0O7_EN V07
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For WKO05, the Hex Code has to be downloaded via HexLoader software. .

11. HexLoader Software Support :

HexLoader related function and description-HY-HexLoader Software User’s Manual. The
HexLoader software can download Hex code in different versions: WK01, WKO02 and
WKO5 writers.

1.5. Attention

1.

When loading the power, it is suggested to connect 9V Adapter, and then connect to USB Line;

when removing the power, please disconnected USB Line first, then remove 9V Adapter.

Error &
The message Verify Fail! will be revealed when the first time that Programmer, WKO05 is

power-on. Never mind it because it just means the Flash memory of Programmer is empty

If the function, “Programming time limit” of WKO5 is executed and the programming time ran out, the

Error 8 PPDEJ
am Counter = 8 .
message will be revealed when you press the program button and the

programming function will not be activated. At the same time, the information will reveal *Information

1 : Program Counter Enable Left 00000000” if you press the information button.

If the function, “Programming time limit” of WKO05 is executed and the programming time ran out, the

Error &
power of programmer is interrupt and then restart, the message ¥erify Fail! will be revealed

when you press the program button. At this time, the programming function will not be activated.

“Information 1 : Program Counter Disable” will show up if you press the information button.

- ]
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2. Programming Software Operation

2.1. Software Function

In order to ease customers to use HYCON MCU products, we developed Hycon-IDE developing

environment so customers can emulate its end application on our development platform and write the

program to the OTP of HY11P/HY 12P series. Detailed description, please refer to user's manual of

HY-IDE software (http://www.hycontek.com/page2.html).

2.2. Software Window Setup

Figure 2-1 is the program window of HyconIDE, which can be used for emulation and debug

function.

IDE software Yersions+ IC Model Mo+

ICE Interface+ Project Mame+

KitebFeal 113 um |

3 HYIDE - Mode: [Edst] ¥2.80 Chip = HY - 11F13 (4K) ICE Istefsce = OB Fropect -
File Edst Zeamch Yiew Progoumeser  Opfiors  Windows  Revison Hisiory
1 B
B - ] Gz o oy oo F

o

:SP[CH'I' : BRSPS

: SPICNT » 2 —> B RTSERAM Address 77 HRE
; SPICH T ol B 255
; WCS PIN 1450 58 0¥ ) S8R SPICNT

SPICNT = 0 —> SPIBUFEYBit 7 = | B , SPIBUFMIEIt T =0 3%
SPICNT = | —> SPIBUF = ERAM Address 8% Low byte > FSROL
SPICNT =2 => SPIBUF = $3ERAM Address &% High byte -.= FSROH

1

org DO00L
ProReset:
nop
jmp ProBegin
;imp 0
org D004k
Inclade Interrapl.asm

ProBegin:
inclade Syslni.acm

MainLoap:
btsz  LVDCNLVD,ACCE
bl  RLCDG,b_lbat, ACCE
btz LVDCN LVD.ACCE
bel  RLCDG,b_bat ACCE
btsz  RAMFgb_FlashR ACCE

. LT I - Y ¥ ]
main; D;iBetoyiDesoCode\Ritchenfcale\HitchForllFL], arm

ISR ok sus = OECHE
—

w

bain Pragram File+

© 2011 HYCON Technology Corp
www.hycontek.com
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IDE connection status+

Figure 2- 1

Generated file
Checksum+
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2.2.1. Interface Setup
Click “Options” , a window will appear. Click the interface setup, as shown in Figure 2-2.

E@E HYIDE - Mode:[Edit] ¥2.80 Chip = HY - 11F13 (4K} ICE Inteface = USB Project =

File Edit Seaxch View Programomer Optons Wmdows Revision History
o Con o B m g
Click [Optians] + “

’E#E Interface Setup

I
+
Interface Setup+ Interface Setup Build Options

Int Setup ICE Test
Register 0SC Calibration
Chip Slect RENTSIN -+ soiect chipe
Language IEninsh v}ﬁ__ |
Haidwate Interface | Select Language+ |

& |rterface Mode

use = USE Interfaces |

IDE Mode
" emulste and Debug
|| Select
& Programmer4——— Frogrammer+

Program Mermony Select

| RAM 62256 =

Ehss‘

Figure 2- 2
Chip Select > Choose the specific programming IC part no. If programmed IC differs from the

selected IC, Blank Check, Program and Verify will fail.

Language - Choose operation interface language, like Chinese or English.
Hardware Interface > USB interface or Parallel Port interface is selectable.

IDE Mode > Programmer or emulate and Debug is selectable.
Programmer: programming HY11P/HY12P series products.

Emulate and Debug: when users use it with simulator for developing.

© 2011 HYCON Technology Corp APD-HYIDEOO7_EN V06
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2.2.2. Build Options

When interface setup finished, click” Build Options” to select programming configuration. As

E'JE Interface Setup g@g|

described in Figure 2-3.

Interface Setup Build Options | Build Option+
Int Setup ICE Test
Regqister 0S5C Calibration
: Mo Use Area Fill
Generate Files v
[+ Enable Toaol Bar Qw0000
Iv Hex file Fant |1 o
[ D!:ll fI!E No Uss Area V OxFFFF+
Generate Fileg+ y | Listfile ¢ 00
il (" FF )
|~ =mart Compilers
WDT Reset Vectar /
[ [v Srnart Compiler
ACM Volkage [ Optirmization
=
- W Program Protect «—§ | Program Protects
Stack Option Compiler Select
[w Stack Ower resel (+
. |}
Stack Optione [w Stack over STOF -
_ |nput Program Times
Enable Pragrame _,_,_...--"""F Enable Pragram Times Ii;.' Input Program Times«
Times+
Cloge
al
Figure 2- 3

Generate Files > Choose generated file after assembly

Stack Option > Choose whether to reset when stack overflow or stack full after OTP
program operation.

No Use Area Fill > Fill up 00 or FF in unused program space after assembily.

Smart Compiler > Choose whether to simplify assembly.

Enable Program Times - Choose whether to enable Download program times.

Input Program Times - Input Download program times (Maximum: 2147483646. Minimum: 1).

© 2011-2012 HYCON Technology Corp APD-HYIDE0O7_EN V07
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2.2.3. ICE Test
After assembly finished, click “ICE Test” to test ICE operation voltage as Figure 2-4 described
(Connect Adapter 9V and connect USB Line to ICE. Make sure the ICE is connected, and then click
“Option” at working bar, click button “CK ALL”"). After that, the VPP and VCC voltage will be started
testing as Figure 2-4.
VPP voltage while programming: 5.6<VPP<6.6.
VDD voltage while programming: 2.7<VPP<3.6.

I

E-’E Interface Setup Q@E|

Interface Setup Build Options
Int Setup ICE Test
Reqgist 0O5C Calibrati
eqgister alibration Shom PP
SRAM Data Valtage«
&ddress VPP /
Wirite D ata “i,./
Fiead Data Check VPP
Wafrite | Read |
vcc Show WCT
Pragram RO Data (— Yoltages
Address “""J‘L_H‘
Wwiite D ata LWL L
Read Data ] Check vcee
wite | FRead | CK ALL
] Check VPF and VCCe
Cloze

Figure 2- 4

- ]
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OSC Calibration as Figure 2-5; Please note this function only can work on the

programmer "HY10000-WKO05” used the software, Hycon-IDE 3.0 above version and

HyconIDEDMMV3.0 above version. If HAO/LPO Calibration programming started, the code,
OFEH/OFFH of RAM would be meaningful after powering on the IC

The programming time will be 500msec. longer (upon LPO Software Calibration Started).

HAO/LPO Calibration is not doing actual frequency calibration; only provide the difference of frequency

for calculation.

E:’E Interface Setup g@g|

HAD Hardware
Calibration+

The HADQ Frequency

\. HAQ Calibration

Interface Setup Build Options
Int Setup ICE Test
Register 0OSC Calibration

r r ¥

Permizzible Error

value was set for
Calibration +

LPO Software

The LPO Freguency
value was set for
Calibration +

Calibration+ s O

[RAMGE 1300000 ~ 2050000 Hz)

LPO Calibration

|nput LPO
=

[RAMGE 22000 ~ 35000 Hz)

HAD Software
Calibration+

Input HAD He + [2 «=—

The allowed
tolerances

Cloze

Figure 2- 5
HAOQO Calibration:
Name Function
Enable HAO Hardware Calibration and implement the system
Enable H/W o _ _ _
. ) calibration. This function has to be confirmed once the IC model No.
Calibration
has been selected.
Enable S/W Enable HAO Software Calibration. The difference value is saved in
Calibration code OFEH of RAM.
Input HAO Input the HAO frequency value for calibration.
o The allowed tolerance between the calibrated frequency value and
Permissible _ _
the value of being calibrated.

© 2011 HYCON Technology Corp
www.hycontek.com
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LPO Calibration:

Name Function
Enable S/W Enable LPO Software Calibration. The difference value is saved in
Calibration OFFH of RAM.
Input LPO Input the frequency value of LPO to be calibrated.

Note: The function of OSC Calibration related parameters are recorded into Hex Code only can be worked

with software, HYIDE V3.0 or later version.

Therefore, when the Hex Code programmed by HYIDE V3.0 or

later version downloaded into writer via HexLoader software, it can be activated and the OSC Calibration
selections can be revealed correctly. If the software is former than HYIDE V3.0(HYIDE V2.0~HYIDE V2.9),

although the OSC Calibration function is active , the programmed Hex Code has no any data related to OSC

Calibration recorded in it. For this reason, as the Hex Code is downloaded via HexLoader software, the OSC

Calibration function can’t be worked correctly. The original file has to be recompiled by HYIDE V3.0, the Hex

Code will be included related data by then.

© 2011-2012 HYCON Technology Corp
www.hycontek.com
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2.2.5. Software Calibration
HAO Software Calibration:

After Calibration, the difference value is saved in code OFEH of RAM. This function is not doing actual
frequency calibration; only writing in the difference of frequency when the IC power-on.

HAO Hardware Calibration, HAO Software Calibration can exist at the same time. Moreover, the
Hardware Calibration enforced first and then proceed the Software Calibration to calculate the difference
value.

The difference value of frequency defined as 4000HZ/LSB -

The code OFEH data format:

Bit7 : 0= +, 1= - ; Bit6~Bit0 means frequency difference value.
01H mean the frequency difference value is +4000HZ ; FFH mean the frequency difference value is
-4000HZ.

Example:

The set value for HAO frequency calibration is 2000000HZ - and the actual value from IC is
HAO=1920000HZ. The calculation is (1920000-2000000)/4000 = -80000/4000= -20, therefore the
code OFEH will be 1110 1100b

Example 1:

The set value for HAO frequency calibration is 2000000HZ - and the actual value from IC is

HAO=2008000HZ. The calculation is (2008000-2000000)/4000 = 8000/4000=2, therefore the code

OFEH will be 0000 0010b

LPO Software Calibration:
After Calibration, the difference value is saved in code OFFH of RAM. This function is not doing actual
frequency calibration; only writing in the difference of frequency when the IC power-on.
The difference value of frequency defined as 64HZ/LSB.
The code OFFH data format:
Bit7 : 0=+, 1= - ; Bit6~Bit0 means frequency difference value.
01H means the frequency difference value is +64HZ ; FFH means the frequency difference value is
-64HZ.
Example:
The set value for LPO frequency calibration is 28000HZ > and the actual value from IC is
LPO=28128HZ. The calculation is (28128-28000)/64 = 128/64 = 2, therefore the code OFFH will be
0000 0010b
Example1:
The set value for LPO frequency calibration is 28000HZ > and the actual value from IC is
LPO=27872HZ. The calculation is (27872-28000)/64 = -128/64 = -2, therefore the code OFFH will
be 1111 1110b
2.2.6. Attention
When Interface Setup finished, please press “close” and all the set parameters will be saved. Next

© 2011 HYCON Technology Corp APD-HYIDEOO7_EN V06
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time, when you open the file, it will load the record parameters automatically and the IC model No. will

be displayed on the headline of window as Figure 2-6.

EE‘-'E HYIDE - Mode:[Edit] ¥2.80 Chip = HY - 11P13 (4K} ICE Inteface = 0SB Project=

File Edit Search View Programmer “Options  Windows Revisson History
' % 2 oy ooy @

Dizplay the Model Mo, was
proceeded to Program.

Figure 2- 6

© 2011-2012 HYCON Technology Corp APD-HYIDE0O7_EN V07
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2.3. Operation Procedures

Tl BYIDE - Mode:[Edif] ¥3.20  Chip = HY - 11P51 (2K) ICE Inteface = USB Project =

: 7CY Edit Search View AssembledRun Options Windows  Revision History
Open Compiler
main file New(H) Ctrlel ; s
OpenfD) CteleO
Save(S) Ctrled
Open Project Save As
Save All
Close File
Close AL
Save Project _
\ pen Propect
Save Project
Read — Read From Flash Memory
Programmer’ s
Flash Memory Ext() CtlsQ

Open > Open the programmed source code main file.

Open Project > Open the saved project.

Save Project > Save the finished project.

Read the code from Flash Memory > Read the code of programmer Flash Memory.
(Attention: if the code was protective, the data will not be

revealed.
Note: The “Download file to Flash Memory” function has been cancelled. HYIDE has no function which

supports Hex Code downloading.

2.3.1. Open/Save Project
“Save Project” will save all setting included program, the choice of toolbar selection and so on to

*.prj file. Oppositely, “Open Project” can read back the file with all the setting.

Save @
END: | O Kivhenseale | ck B~
KithForl 1P13 prj
i il paaty
@
SE
Eirpizatd
FHATEE
B LA
- [itshForl 1F13 prj ~| BT
TFHEERE (T | g | B
© 2011 HYCON Technology Corp APD-HYIDEO07_EN V06
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2.3.2. Open File and Assembly

I BYIDE - Mode [Edif] ¥2.80

ICE Tsteface = BEH

Chip = BY - 11F1¥ (4K} Faopeet

EichFeal 1F1 Y wem |

LSPICNT ; mEMSP IR

SPICNT = 0 == SPIBUFISBu 7 = | B§ , SPIBUFRMEx 7 =0 M
SPICHT = | == SPIBUF = FIFRAM Address i) Low byts --» FSROL
SPICNT = 2 = SPIBUF = BERAM Addrews 0 High byte -.> FSROH
SPICHT » 2 == B SETRAM Addvess $E77 5000 1F

Bap

mp  FProBegis

; mp 0
org  OD0HK

leclude latssrnptasm

:i’lanl:

| include Sysluazm

bz
Dizplay Main bal
Program File., || i

[ Bl
l | sz

i-hu!.m:

LYDCHLVD ACCE
RLCDGb_1bat ACCE
LVDCN LVD,ACCE

RLCDAG b _Ibat ACCE

EAMFg.b_FlashE ACCE
(T LY )

main: BryBsccyiBsscaCods\KicchenSoalaiRicchfor11FLY, s

-

e T

Figure 2-7

Open source code main file and it will be displayed as the assembily file. If the displayed name

differs from main file, points the mouse to the specific file and presses mouse right key. Set this file as

the assembly main file as shown in Figure 2-8.

© 2011 HYCON Technology Corp
www.hycontek.com
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Mainine KitchForl IP13.asm ]

L A

13

: SFICNT : S EISPIRI SIS

; SPICNT =0 == SPIBUF#YBit7 =158, SPIBUFSYBL7=0 8
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Click Mouse Right Key.
Set Program Main File

org 0000k
jmp  ProBegin
nop
jmp 0
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Inclode Interrupt.asm
FroBegin:
include Syslniasm #ile: KitehForl 1P13 asm
; file: Madn ine
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mvi  SPIINDEXL.F,ACCE et Boolamark g
; AT Got Bookmark
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p f ot e | 2
11 Modified
Figure 2- 8

Assembles Source Code and download the file to programmer or IDE Flash Memory, as Figure

2-9 illustrated.

T HYIDE - Mode:[Edit] ¥2.80

Chip = HY - 11P13 (4E)
Programmer Opbons Wmndows Revison History

ICE Inteface = OSE Project =

File Edit Search View

i _
i 1l 2 - o= 5

Azzemble and
Dawvnload to IDE
Flash Memary .

Figure 2- 9

BOK

ﬂ Enter Password E@@

Cancel

Figure 2- 10

© 2011-2012 HYCON Technology Corp
www.hycontek.com

APD-HYIDE0O7_EN V07
page 18



Prog’rammer(Frequency Calibration) HVC\”,\“
User’s Manual HYCON TECHNOLOGY

.E Enter machine I BE|E|

!: med by, oo sy 100 GOOO0S00

' Any Programmes cen read Flach
LAY

Figure 2- 11

mﬁ Meszage [:' E' rz'

H/ HAO Calibration Function ON!

SA HAO Calibration Function ON!

SMW LPO Calibration Function ON!

Flash had been protected !!

read only, Programmer 1D:80000400

Program had been protected !!

C:AProgram Files\HylDE\HyconlDE\DemoCode\KitchenScale\KitchFor11P13.hex Download OK
Program Times Download OK !!

Program Times Function Enable **** Program Times = 1000

< | >

Figure 2- 12
1. When using USB interface, the assembly finished program code will be loaded into programmer or

Flash Memory of IDE for mass production programming.

2. Before downloading code to programmer Flash Memory, system may require to enter into password.
This function enables users to monitor the code from PC to programmer Flash Memory. Please note
that password can only include 6 digits (ASCII Code). In order to protect the code that users
developed, the password must be entered before downloading the code into programmer. If the
password entering step is cancelled during downloading procedure, it means that the code will not

be allowable to be read from programmer. (as Figure 2-11)

After you entered the password, you will need to confirm if you would like to assign the specific
programmer. If you choose yes, only use the assigned programmer can read the code from Flash

Memory. Oppositely, if you choose No, you can read the code by all programmers. (as Figure 2-11)

Note: once you set the password, it will be the operating password of the programmer. This
password has to be entered before you read the code. Please memorize your password to ensure

the code can be read in the future.

In addition, every time a new code is downloaded; the programmer will ask you to enter a new
password afresh.
3. If there is enabled program times in the assembly option, information column will display the
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programming times as shown in Figure 2-12.

4. After assembling completed, Hex filename and Checksum will be displayed in underneath section,

as Figure 2-13 illustrated.

Download To Programmer’ s Display OTP Display Program
Flash Memory Connection Status Checksum
E:ZCYPRESE"WIDELCHM TestDeno’ TestDemoboard. hex Body S board Checksum = 0xDOCO
Figure 2- 13
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2.3.3. Download Hex File to Programmer or IDE Flash Memory
For HY11P series, this function has not been supported on Hycon-IDE 3.0 hereafter. If users would like
to download Hex File, please download by software, HY-HexLoader and following the Users’ Guide to do
it.
Note: For HY12P series, this function has not been supported on HyconIDEDMM V3.0. To download Hex
File, users must use compiler source code method to the writer.
2.3.4. Read the Code from Flash Memory
The function of “Read from Flash Memory” helps users to ascertain whether the code of
programmer Flash Memory is the same with Download Code. The Password entered must in
accordance with the Download Password, so the data will be revealed, as Figure 2-15 shown.
If the Flash Memory has assigned a certain Programmer, only the assigned Programmer can use
the mentioned way to read the code from Flash Memory.
5 Edit Search View AsemblefRy
Hew() Cul+N
Open(D) Ctrl+O 3
Save® Ctl+3
Save Az
Save Al

Cloze File
Cloz Al

Open Project
Save Project

/’t Read From Flash Memory

Exat(Q) / Ctrl+Q

| y

ERRER K

BOK Cancel

S Program Memory

000 [78DC (0000 TFFD 0000 DOOF FOFF D010 FOFE D011 FOFD D012 FOFC
001 (7801 8226 BC26 TBA%9 8C26 DO3B FOD4 DO3A FODS D039 FOD6 64D4
002 66RAA 64D6 1CB1 66AB 62D2 BEARB 7809 92D2 26A9 26BA 26AB 0601
003 6EAB 7848 0604 6G6ED 0600 66EC 64EC 18A9 64ED 1CBRA AB2B 7T83E
004 06FF 66A9 64D4 1001 66AF 64D5 1401 66B0 64D6 1400 66B1 0600
005 66AA 6401 12AF 6401 16B0 6400 16B1 0600 AE01l O6GFF 16AY9 36AA
006 |FOE8 0606 D007 FO002 DOOT FOO02 DOOT FOO0Z 3629 TFF8 DOD6 FO002
0017 0603 882B 52A% &52B1 52B0 52AF 3629 TFF9 86D2 7827 B6D2 T81B
008 0104 AOZB 7801 7813 000C FODT 0607 DOD4 FO0O1 DOD5 FO001 DOD6
009 |FORF DOD5 FOBO DOD6 FOB1 86D2 780R 84D2 AZDZ 94D2 DOD6 FORE
00A |96D2 DOAF FOF2 DOBO FOF3 DOB1 FOF6 882B bL6F2 56F3 5L6F6 BEF6
00B [780A 64C5 66A9 882B AEBl 982B 52F6 52F3 52F2 36A9 TFF8 9248
00C |6EAT 32A7 HEAD 32AD 0011 3B29 O6F0 6929 7807 0D29 6F2D 332D
00D  |B426 7801 8426 0003 DOFD F01ll DOFC F012 DOFF FOOF DOFE FO010
00E 665E 0617 662D 000C FOB0 0680 OCO1l 3629 7TFFD 000C F100 0680
00F |6632 0606 66C5 0630 666D 0600 666F 0600 666E O06FF 6670 0CT2
010 6675 06FF 6677 |C000 F79D CO000 FTAC 0C2B OCFO O06FB 66B7 0601
011 |66B6 98A8 CO000 F95D B82B 7801 78CA 8BA8 OCB6 0604 6697 0697
012 6682 0601 6683 0602 6684 0010 CO00 F612 DOCZ2 FO095 DOC3 FO096
013 0692 6681 0698 6682 0603 6683 0603 6684 0601 6685 0010 C0O00
014 D098 FO0SC 6O0BE 010F 0709 6422 10BR 6695 0600 14BB 6696 DOC2
015 |F094 0692 6680 0695 6681 0697 6682 0603 6683 0602 6684 COO0O
016 6681 0692 6682 0605 6683 0602 6684 0603 6685 CO000 F652 D092
017 FOAOD 060A 6695 0692 6680 0695 6681 0696 6682 0603 6633 0601
018 |F652 D096 FODO DO0OS7 FOD1 D098 FOAR1l 0C92 0C9%3 0C9%4 0C95 DOBC

YmammmmA s oo ose s A M e r o= m

Figure 2- 14
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3. PC Online Programming
3.1. PC Online OTP Programming

Tl HYIDE - Mode:[Edit] ¥2.80 Chip = HY - 11P13 (4K) ICE Inteface = USB Project =

Fie Edit Search View Frogrammer Optons Wmdows Rewvision History
¥ . y Oy
1?1 A [ _,_JfD'""( IJ:-( D: nt»._
Blank "
Display Hex Codes Checke || Frograms || Werify Read+ Auto+
Figure 3- 1

L.

Figure 3- 2
Blank Check, Programming, Verify and Read Commands can be implemented when the
programmed file being successfully loaded into programmer or IDE Flash Memory. On the contrary

those commands will not be activated if the download failed.

OTP Chip does not

_Q__I]__i_p ID Error!! Program Chip ID = 00043 -= match with the
selected IC

Figure 3- 3

OTP online

E:WCYPRESS, IDELCMY TestDenc TestDenohoard. asn in board  Checksuw = 0xDOCO

Figure 3- 4

OTP missing

’D:\CYPP.]!SS\ID!-Tunx\HY-?C\IDETEST\llplQ-lZSus:\KithorllPlS.hax EEEEENSREEEE Chocksuu = 0x45AC

Figure 3- 5
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Make sure the selected programming IC part number is the same with the OTP part number in
the topic window as Figure 2-6 described. When programmer executes Blank Check, Programming
and Verify commands, Program will check whether the IC part number and OTP programming part
number are identical. If the part number is different, the data will not be written into OTP and an error
message will be displayed in information column as Figure 3-3 described.

If users intend to find out whether the part number is correct before programming, point the
cursor to "IC Connection Status Display” and click the mouse left key. If the selected IC is correct, a
message will show up as Figure 3-4. If it is incorrect, the message will be displayed as Figure 3-5. If
“Enable Program Times” has been marked up, the spare program times will display in the message

column as Figure 3-6 illustrated.

|F"rnqram Times Left 998

Figure 3- 6

- ]
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3.2. Blank Check

O
The icon of Blank check is * | The internal code of Blank ICs that have yet been programmed

is OXFFFF. The purpose of checking the IC is to make sure the OTP address content is OxFFFF. If the

IC selection is correct and the content is empty, a message will appear as Figure 3-7.

S Mezage

SBM Blank OK

Figure 3-7
If the IC selection is incorrect or the content is not empty, a message will show up as Figure 3-8

described.

N Meszage

Figure 3-8

e — ]
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The icon of Program is
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g
*  The purpose of programming is to write Compiler accomplished

program into IC OTP. When programming is completed and the IC is assembled as finished goods,

programmer can operate the program as users commanded.

Program the downloaded or assembly finished Hex file (displayed at the bottom of the column)

in the selected IC and verify the correctness of the programming content (please refer to Chapter 2.3.2

or 2.3.3 for programming procedures).

If the selected IC is correct and the programming succeeds, message will appear at the

information column as Figure 3-9 illustrated. If “Enable Program Times” is ticked up, the enable

program times will minus 1 and the program times left will be revealed in the message column.

S Meszsage
‘Program Chip QK

Program SBM 0K
Verify Chip OK
Verify SBM OK

Program Times Left 99999997

-

Show Program Times

(1f Program Times Function had been

Enable)

Figure 3- 9

If the IC selection is incorrect or the programming fails, a message will show up as Figure 3-10.

© 2011 HYCON Technology Corp
www.hycontek.com
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Program SBM Fail

Figure 3- 10
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3.4. Verify

G
The icon of Verify is "™ . The purpose to verify programming IC is to compare if the program
written into IC OTP equals to the program downloaded to programmer or IDE Flash Memory.

Verify programming IC content consistency with the downloaded or assembled Hex file
(displayed at the bottom of the column). If the IC is protected by program, this verification is ineffective

or the comparison failed.

If IC selection and program verification is success, a message will appear as Figure 3-11.

Verify Chip OK

|'1.r'erif5r SBM OK

Figure 3- 11

If IC selection is incorrect or the program verification miscarries, a message will pop up as Figure 3-12.

Verify Chip Fail

|Errur at Dx0000H

Figure 3- 12

e — ]
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3.5. Read

i+
The icon of Read is ™ . The purpose to read the IC is to verify the consistency of OTP

Checksum and programmed Hex file. To read IC content, the procedures are illustrated as Figure 3-13.

Its content will reveal at "Display Code” window.

If the IC is protected by program, this function is ineffective or the comparison failed.

E’E HYIDE - Mode:[Edif] ¥2.90 Chip = HY - 11F13 (4K} ICE Inteface = I3B

File Edit RBeamch View Programmer Opton:  Windows  Eevision Historyr

ELy 10i o O
J i1 i I'_"I“ - DJ: Cis !

OTF type+

__":{ Mesmage

OTP Chip is 11P13
Read Checksum = IxCBH3

1 [2 E} la |5 |6 -
T9EZ 0000 0000 DOOF FOFF DOLD
98ZB 1700 1701l 1702 1703 BZZ2G
G461 G6FA 0GBl GCFA TBEOS G4R3
E427 TFFE 8427 6461 66F1 6G64A3
IFART 0600 18A3 O4ED BEZE TEOZ
TFE4d 0600 0060 6661 TFFI 0601
T&ED3I 6461 O0CFS TEOT 6461 G6EFD
T&06 &601 DOOF FOFSY DOLO FOFE
T952 BC26 DO3E FODd DO3IR FODS
T&EA &4Dd 18AF GGHAT 64D5 LCBD

Checksums+

Figure 3- 13

© 2011 HYCON Technology Corp APD-HYIDEOO7_EN V06
www.hycontek.com page 27



Programmer(Frequency Calibration)
User’s Manual

HYGON

HYCON TECHNOLOGY

3.6. Auto

The icon of Auto is ! . Auto integrates Blank Check, Program and Verify function. If user
selects Auto, it will first check whether the IC is blank, then to program and verify.

After the execution succeeded, a message will be displayed as Figure 3-14 displayed. If the
option, "Enable Program Times” is ticked up, the program permitted times will reduce 1 and the

program times left will be shown in the message column.

S Message
SBM Blank OK

Program Chip OK

Program 5BM OK

Verify Chip Ok

Verify SBM OK

Program Times Left 999999397

Figure 3- 14

If any function fails, the whole process will stop and display an error message in the message
column.

e — ]
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4. PC Offline Programming
4.1. Program Description
As the development process evolves to mass-production, the programmer can be used alone

when programming on the production line. It is not necessary to connect the programmer to the PC.

*Attention: When use programmer, please make sure the 9V Adapter has been connected before
USB line was plugged in PC. Please don’t put in or pull out 9V Adapter when programmer connected
with PC or the PC may crash.

0000 [ ]
P4 LCM
| irformation  Slank  Program HAG Error . Error Ok
(> |: )
Figure 3- 15

(For the description of device, please refer to chapter 1.2)
L1 - Success message signal, green LED.

L2 - Failure message signal, red LED
Blank Check failed message signal, red LED.
HAO Frequency Calibration error message signal, red LED.
L3 - Busy message signal, red LED.
S1 - Programming button (Program->Verify), for offline program operation.

S2 - Blank Check button, for offline operation.

To implement offline operation, Hex file must be firstly downloaded to programmer Flash

Memory. The procedure can refer to chapter 2.3.2 or chapter 2.3.3.

To implement offline operation, press S2 button can check if the IC is blank and the L1 Green
LED should be lighted up. We suggest S2 button should be pressed first for checking if the IC is blank

before you press S1 to proceed programming to ensure the programming will be success.

S1 Button is programming button. Its procedures are: Blank Check - Program - Verify and the
L3 (Busy) message light should be lighted up. If "Program Protection” of “Assemble Option” is picked
up before downloading data to Flash Memory, program protection will be executed after Verify
completed. If "Program Protection” is not picked up, it will stop after Verify accomplished, L3 (Busy)

e — ]
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4.2.

message light will go out and L1 Green LED will be lighted up.

When Programming finished, please press S2 to check if the IC is blank. At this moment, the L2
Red LED should be lighted up means the programming is success (because the data has been

programmed into IC, so Blank Check is failed.)

If any failure or error happened during execution procedures, L2 Red LED will be lightened up.

On the contrary, L1 Green LED will be lighted up if success.

Program Times Restriction
The menu of "Assemble Option” in interface setup has an option of "Enable Program Times” as

described Figure 2-4. This option restricts the permitted program times of download program.

This is a safety mechanism that restrains the permitted program times, preventing it from

over-programming on the production line.

After ticking up "Enable Program Times”, key in the program times in the column below "Input
Program Times” (maximum is 99999999, minimum is 1). This argument will be written into EEPROM of
the programmer after the compiler programmed file is downloaded to Flash Memory. Afterwards, the
enabled program times will reduce 1 each time when programming completed. If the value reduced to
0, the programming action may not be executed. At this time, an error signal (Red LED) will be lighted

up but Blank Check still operates normally.
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5. Information Button
5.1. Information Button
»  Press Information button(S3), displaying HYCON IDE message.

[1n+'cir-!“ Lion B 3 ]

Wait for
1 second

|
'} . - -
(mh=Ietnla J.l Ll =

['.IJE' loom o lse ]

»  Press Information button again, displaying Program Counter Times message.

1. If Program Counter Times is enabled.

Wait for

Information 1 = — (Frodram Coupter
1 second F:.rl.-||-:| I.E"

Wait for
2 seconds

[F'r*-:wzlﬁ am_Counter J

I--.E'_F-t. ICI._II:IIE':-EE:‘-E :

Program times left

2. If Program Counter Times is disabled.

[I mformation 13 ]

J

—> [F'l“n:-':r'-esurfu Counter ]

Wait for "
bl =

1 second
»  Press Information button again, displaying VDD and VPP voltage.

— -
R
[

-
[
| o —

11}

Display programmer’ s current
/ VDD and VPP voltage

[I nformation 2 ] — [= DD

Wait for e
L

1 second
»  Press Information button again, OTP ID and Flash stored ID.

et =]
w T

B
(0]
n

[Er'ui ormatiofn 3 = ]-’ [_

Wait for
1 second

b

2l
L A
= Ja
H
—

Bo®
feeess)
i
=]
i

»  Press Information button again, displaying error message.

1. If there is no error message.

Information 4 3 — » [FHSE Che
Waitfor | ... o = e A
1second (=i = .JI'I = ExisanLn |

Saved in Flash Mimory
Checksum

e — ]
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If there is any Frequency Calibration function is active.

Information 4 : HHAO=xxxxKHZ Che
>
Wait for 1 Cksum= 0x45AC
second

Display the message by the time the hardware/software Frequency
Calibration finished and the Checksum of Flash Memory

2. |If there is error message.

[Irﬁ"-:-'r'-r-usa‘i;:i-:-ﬂ 4 3 J_. [Er*r*-:w

Wait for
1 second

"I 4=

1]
|. ol
—/

Display current error message

»  Information 4-6 will display the message by the time Frequency Calibration finished. If the whole

calibration is completed. The message will be displayed as follows:

Information q : HHAO=xxxxXKHZ Che
—_—
Wait for 1 Cksum= 0Ox45AC
second

-

Display the message by the time the
hardware/software Frequency Calibration finished
and the Checksum of Flash Memory

e
waitfor1 |Cksum= O0Ox45AC
second

Display the message by the time the
hardware/software Frequency Calibration finished
and the Checksum of Flash Memory

—
Wait for 1 Cksum= 0Ox45AC

second /7

Display the message by the time the
hardware/software Frequency Calibration finished
and the Checksum of Flash Memory

[Information 6 : ] SLPO=xxxxKHZ Che ]

»  Information 7-9 will display the configured calibrated message. The message will be displayed

as follows when fully activated:
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i : Cal . H-HAO= 2
Information 7 : | _, |©® 0= 2000
Wait for 1 KHZ
second
Display the message which is the current value
was set for Frequency Calibration
i . Cal . S-HAO= 2000
Information 8: | __
Wait for 1 KHZ
second
Display the message which is the current value
was set for Frequency Calibration
i . | . S-LPO= 28.
Information 9: . |cal-S-LPO= 28.00
Wait for 1 KHZ
second

Display the message which is the current value
was set for Frequency Calibration
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5.2. Error Message

» VDD Error
[Frrar 1 J
VDD = 2.12U

» VPP Error
[Frrar 2 J
UPP = 4.92U

» OTPID Error

[Frrar 3 J
Chir ID ERROR

> Blank Fail
[Frrar 4 J
Blank Fail'

» Program Fail
[FFFGF 5 J
FProgram Fail'

»  Verify Fall

[FFFDP F J
Verifg Fail!

> Protect Fail

[FFFGP e J
Protect Fail'

» Program Counter left zero

[FFFGF = FPDQJ
ram Counter = 8

- ]
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6. Revision History
Major differences are stated thereinafter:

HYGON

HYCON TECHNOLOGY

Version Page Revision Summary
V03 All First edition
V04 7 Add notice of Programmer, WK04
V06 5-7,12-13,16, 21 Revise related information of Programmer, WK05
32-33 Add Frequency Calibration related description
V07 All Add HY12P Series related operation description.
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